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Ch. 4: Projectile Motion

Investigation 1:  Projectile Motion using Video Analysis

Objective
To develop the equations governing projectile motion.


To discover the independence of horizontal and vertical components of projectile motion


Use fitting techniques to justify the projectile equations
Materials
Logger Pro software 



Lab Pro Interface 



Video Analysis movie
Introduction
In this investigation you will begin to examine the motion of a basketball being thrown through the 

air. This motion is an example of projectile motion that can be described by studying two 



independent motions: i) a vertical free fall motion, and ii) a horizontal motion with constant velocity.


In this tutorial, you will use the video analysis feature of the Logger Pro 3.3 to learn how to:



1) Open the video analysis feature.




2) Set up graphs for analysis.




3) Analyze a video.




4) Perform further analysis of the data.

Activity 1
Video Analysis
1. Start Logger Pro 3.4 and from the File menu click Open. In the Open dialog box click on the Sample Movies folder and then click on the folder Basketball Shot. Double click on the Basketball Shot file to open the movie. 
2. First of all, note the five buttons on the lower left side of the Movie Player. The left-most is the Play button. Click it now to play the movie. The next button to the right is the Stop button. It will stop the movie during replay. The third button from the left rewinds the video to the beginning. The next two buttons move the video to the previous or next frames. The slider bar lets you scroll through the video. Click the play button to watch as Dave throws the ball.



A graph and data table will also be displayed. If necessary, resize and move the graph to the 
right of the movie. The y axis should now show "Y" (vertical position) only. 

1. Now we need to set a scale for the analysis. When the video was made, a meter stick was placed in the black part of the floor next to the basketball court. Click the Set Scale button, 


which is the fourth button from the top of the movie player on the right side. Now click and 
drag the mouse from one end of the meter stick to the other end. 

CAUTION: It is very important that you click and drag accurately between the two ends of the stick. The smallest deviation will result in large errors later during graphing and analysis. 


A pop-up dialog box will appear. The default of “2" for the Distance and "m" for the unit of measure is correct, so click OK. 
2. Next click the Play button, and just before the ball leaves Dave's hand, click the Stop button. Click the Next Frame button and advance the movie until the ball has just left his hand. (Be careful here: You must advance to the first frame that shows the ball not in contact with the hand.) Now click the Add Point button (second from the top). Move your mouse over the movie and use the cross hairs to identify the middle of the ball. Click the mouse once. Notice that a mark is left on the screen and the movie advances one frame. Mark the center of the ball again and repeat this process until the ball almost hits the floor. 
3. Now click the movie Play button to see the ball move through the air, and watch the trail of its horizontal and vertical position. The graph shows vertical position vs. time. 

4. Rewind the movie and again advance it to the frame where the first point was added. Click the Set Origin button (third from the top) and move the cursor to the first point on the movie. Click the center of the first point; this will set the origin (a set of axes appears) at the first frame the ball is in the air. 
5. Now we need to synchronize the movie with the origin. At the bottom of the movie window click on the Sync Movie to Graph button (second from the right). The Movie Synchronization dialog box appears. In the Graph time box type “0” and check the box “Synchronize VA dataset with selected dataset”. Click “OK” to close the dialog box. The graph should now adjust showing the first point at (0,0). 
If you have problems with synchronization call your instructor for help before you proceed.

Activity 2
Graphical Analysis

In this activity we will develop the equations that describe the motion of the basketball. 

1. You should be able to recognize from the movie that the trajectory of the ball follows a parabolic path. You can also observe the parabolic path directly from the graph. Click on the Time axis and choose X. The graph now shows the 2-D parabolic path in a Yvs X graph. In other words it shows the spatial relationship between the height and the horizontal displacement of the ball. As you can see, the height of the ball increases until it reaches its maximum and then it decreases as the ball reverses direction. All along, however the horizontal displacement is continually increasing. 
2. Let us now study the time dependence of the various quantities involved in a projectile motion: 1) vertical displacement (height), 2) vertical velocity, 3) horizontal displacement, and 4) horizontal velocity.  Before you continue, write below the equations that describe the four quantities above. 



Vertical displacement:




Vertical velocity:




Horizontal displacement:




Horizontal velocity:

3. Switch back the graph to display only the Y vs. Time data. The graph appears to be parabolic and it can be easily confused with the Yvs X graph you observed above. There is a distinct difference between the two: The Y vs X represents a 2-D spatial relationship of vertical and horizontal displacements which is the real physical situation. The Y vs Time graph has no physical meaning. It simply represents the time dependence of the vertical displacement of the 1-D free fall part of the projectile motion.  Let us test now if the Y vs Time curve is really parabolic, or in other words if it is represented by a quadratic equation. 
4. From the Analyze menu choose Curve Fit... In the Curve Fit screen choose the “At2 + Bt + C (Quadratic)” function under the General Equation box. Values for the coefficients A, B, C should appear in the Coefficients box. Click OK to exit. A data box with the quadratic equation “Y = At2 + Bt + C” and the coefficient values should appear on the graph. 
Questions:

1. Does the quadratic fit appear to be acceptable?

2. What does each of the coefficients represent physically? Complete the table below.

	
	Value
	Physical meaning

	A
	
	

	B
	
	

	C
	
	


5. Click on the label of the vertical axis and choose “More…”. In the dialog box check the “Y velocity (m/s)” box. Leave the “Y (m)” box checked. Both graphs should now appear. From the “Analyze” menu choose “Linear Fit”. The data box displays the linear fit equation “v = mt + b” and the values for the slope and y-intercept of the line.
Questions


3. Does the linear fit appear acceptable?
4. What is the physical meaning of the slope and y-intercept of this line? Complete the table below.



	
	Value
	Physical meaning

	m (slope)
	
	

	b(y-intercept)
	
	


6. Add to the graph the horizontal position data “X (m)” and linear fit it.
Questions


5. Does the linear fit appear acceptable?

6. What is the physical meaning of the slope and y-intercept of this line? Complete the table below.



	
	Value
	Physical meaning

	m (slope)
	
	

	b(y-intercept)
	
	


7. Complete the analysis by adding the “X velocity” data to the graph and linear fit it
Questions


7. Does the linear fit appear acceptable?

8. What is the physical meaning of the slope and y-intercept of this line? Complete the table below.



	
	Value
	Physical meaning

	m (slope)
	
	

	b(y-intercept)
	
	



Call your instructor to discuss the following questions:
Questions


9. Which coefficient of the quadratic formula would give the value of g?

10. Which quantity from the Y velocity vs time line should give you the value of g?

11. Are the two values close? (A 5% difference is acceptable due to errors.)

12. Which quantities represent the y component of the initial velocity? Are they close?

13. Which quantities represent the x component of the initial velocity? Are they close?   
14. How long before the ball reaches its maximum height? What is the y velocity at that point?

15. Suppose that the movie was shot on a planet where the gravitational acceleration is twice as much as the one on earth. What would be the maximum height reached?

16. Suppose that the movie was shot in the outer space where the gravitational acceleration is zero.  Assume the ball has the same initial velocity. On the graph below draw the same four graphs. Label them properly.
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Investigation 2:  Projectile Motion using Physlets©

Activity 1
Illustration 3.4
1. In the Physlet Physics folder click on the start.html file. From the web page that is displayed choose on the left pane “Ch. 3: 2_D Kinematics”. Click on Illustration 3.4 Projectile Motion. Follow the instructions for a preliminary investigation of projectile motion.
Activity 2
Exploration 3.5

1.  On the left pane click on “E.3.5”. The screen shown on the following page appears.
2. A projectile is launched at t = 0 s (position is given in meters and time is given in seconds). You 
may change the projectile's launch angle and initial speed and the height of the hill by using the 
text boxes and clicking the "set values and play" button. 
3. For h = 0 m, vary the projectile's launch angle and initial speed and consider the following 
questions. 

i. For an initial speed of 20 m/s, what launch angle will provide the maximum range of the projectile? 




Angle:__________

b. For an initial speed of 15 m/s, what launch angle will provide the maximum range of the 
projectile? 




Angle:__________

c. Are the two angles the same? If they are, does this suggest a trend here? Choose a couple of other speeds ranging from 10 – 20 m/s and try it. Is the maximum range angle the same as in a) and b) above?




Angle:__________

d. The angle you are finding is the angle of the initial velocity vector. On the figure below sketch the direction of the initial velocity vector and indicate the angle. 
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e. Draw the velocity vector at the peak. What is the angle of the velocity vector when the object is at the peak? Angle:___________
4. Now you should be ready to play with changing the angle of the initial velocity vector. You should be able to determine how to find this angle using equations from your text or instructor. Do so. If you use a “canned” formula called the range formula you should know how this derives from the basic kinematics equations. Find and write down the range formula (only valid for h=0, where h means a change in height here). 


Range formula: 
5. To find the angle for the initial velocity vector that gives the maximum range consider the trig functions you see in this formula. What is the maximum value of the trig function in the maximum range formula above? At what launch angle is this value maximum (careful)? 

Trig Function:___________


Max Value of trig function:___________


Theoretical initial angle for max value:____________
6. For the value of launch angle in (5), what is the value of the initial speed that will hit the target? 
a. In the animation measure the range from launch to the target (horizontal displacement) using the mouse click measurements. 



Range=______ 

b. Now use the range formula to predict your initial launch speed. 



Predicted vo= 

c. Try out your prediction. Does it work? 

7. What other value(s) of the projectile's launch angle and initial speed will enable the projectile to hit the target? 

a. Use the range formula to try several values of initial launch speed and launch angle. Make a short table of predictions. 

	Launch Angle (o)
	Predicted v0 (m/s)
	Check if predicted
v0  agrees (Yes/No)

	20
	
	

	30
	
	

	40
	
	

	45
	
	

	50
	
	

	60
	
	

	70
	
	


8. Are there any two values of launch angle that require the same initial velocity to hit the target? Do you see a trend here? What is it?
Activity 3
Physlet Problems
1. Problem 3.7: A projectile is launched as shown in the animation (position is given in meters and time is given in seconds). Where does the ball reach its minimum speed, and what is its speed when it gets there?
i. Position of minimum speed:__________________

ii. How do you know?

iii. Minimum speed:__________________

iv. How did you calculate it? Show work.

2. Problem 3.8: A hunter (off screen) aims his rifle at an apple in a tree as shown in the animation (position is given in meters and time is given in seconds). At the instant the bullet leaves the rifle, the apple starts falling from rest.  Which of the above animations correctly depicts the hunter's aim that hits the apple?  Note: All three show the apple being hit, but only one animation depicts correct physics. 
i. 
Correct Animation._________
ii. 
How did you decide?
3. Problem 3.9: A projectile is launched with an initial speed of 20 m/s as shown in the animation (position is given in meters).   The time display is suppressed, but you can still click-drag to get coordinates.  A line is also shown that represents the initial direction of the velocity.
a. What is the launch angle? ___________ (Explain below)
b. What is v0x?___________ (Explain below)

c. What is v0y? ___________ (Explain below)

d. What is the maximum height the projectile will reach?_____________ (Explain below)

e. How long does it take the projectile to reach that height? ____________ (Explain below)

f. What is the total time that the projectile is in the air? ______________ (Explain below)

4. Problem 3.10: A projectile is launched when the yellow Lamborghini (not shown to scale) goes by at t = 0 s (position is given in meters and time is given in seconds).  You may change the projectile's launch angle and initial speed by using the text boxes and clicking "set values and play."  Find the relationship between the velocity of the Lamborghini v0L , the initial velocity of the projectile v0, and θ such that the projectile will always hit the car (on the yellow dot exactly).  When you determine the relationship, make sure and test it with a few values of v0 and θ. 
i. Relationship between v0L, v0 and θ?__________________
ii. How did you decide? Explain.
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